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Sebelumnya saya panjatkan puji syukur ke
hadirat Allah S.W.T yang telah memberikan
saya kesempatan untuk menyelesaikan
dokumentasi karya saya yang berjudul The
Making of Piandu

Terimakasih kepada keluarga yang telah
mengizinkan saya untuk tidak kuliah
terlebih dahulu, meskipun dengan berat
hati. Terutama adikku Novi Retnosasi yang
telah mendukung apapun yang telah kupilih.

Terimakasih kepada OSS (Open Studio
Society) yang telah menciptakan suasana
nyaman dalam mengerjakan karya ini.

Terimakasih kepada Icha, Iput, Eko dan
semua yang telah membantu saya baik
langsung maupun tak langsung, karena
tidak mungkin saya sebutkan satu persatu.

Buku ini merupakan kumpulan dokumentasi
berupa tutorial yang membantu pembaca
untuk belajar membuat PIANDU. PIANDU
merupakan sebuah Piano dan Seruling
dalam bentuk digital yang dikemas dalam
sebuah aplikasi. PITANDU dibuat
menggunakan software-software berbasis
open source diantaranya Blender, GIMP,

dan Inkscape. Hal tersebut merupakan
salah satu alasan kenapa source pembuatan

PIANDU saya bagikan secara gratis. Selain
bisa dijalankan di berbagai macam operasi
sistem, PIANDU juga bisa dipelajari oleh
siapapun yang berniat belajar.

Blender merupakan software pokok yang
digunakan dalam pembuatan PIANDU.
Blender digunakan untuk modeling,
teksturing, animasi, game logic, dan game
engine. Saya menggunakan Blender versi
2.49b dalam pembuatan PTANDU. Meskipun
saat itu sudah ada Blender 2.5, namun
karena game engine pada Blender 2.5 saat
itu belum cukup stabil, maka saya putuskan
menggunakan Blender 2.49b yang sudah
cukup stabil.

Dalam buku ini saya akan bahas tiap tahap
pembuatan PIANDU berupa tutorial,
sehingga pembaca bisa langsung membuat
PIANDU dari nol. Blender yang saya
gunakan dalam buku ini juga menggunakan
Blender 2.49b. Jika anda selalu update di
situs pribadi saya (http://panduaji.net/)
anda bisa menemukan bagian-bagian
tutorial pembuatan PIANDU dalam versi
Blender 2.5.

Semoga dengan adanya buku ini bisa
bermanfaat untuk siapa saja yang membaca
dan mengamalkannya

Penulis

Pandu Aji Wirawan



SEJARAH

Saya teringat sebuah perkataan Bung
Kano pada sebuah buku yang berbunyi
"Bangsa yang besar adalah bangsa yang
menghormati jasa para pahlawannya".
Jadi tidak lengkap rasanya jika tidak
menuliskan orang-orang yang berjasa
dalam pembuatan Piandu, sehingga
saya putuskan untuk menuliskan sedikit
sejarah tentang Piandu.



.piano

Berawal dari JC of SMK Negeri 1 Surabaya,
sebuah komunitas ‘'ilegal' karena belum
diakui secara de jure oleh sekolah. Saat itu
kami dibimbing langsung oleh Bu Endah
dan Pak Lukman. Tujuan utama komunitas
ini adalah untuk share ilmu yang tidak
diperoleh di sekolah ke sesama anggota.
Kala itu 90% anggotanya merupakan anak
jurusan Rekayasa Perangkat Lunak (RPL).
Mereka share mengenai pemrograman java.
Saya dan seorang teman saya Rara Indah
Permata Sari berasal dari jurusan
Multimedia, kami tidak mendalami
pemrograman, namun game dan animasi.

Setiap hari Sabtu, kami dikumpulkan di
salah satu labolatorium sekolah untuk
berbagi dan presentasi karya-karya yang
telah kami hasilkan. Awalnya saya jarang
presentasi, karena memang saya dulunya
malas untuk berkarya dibidang 3D, namun
setelah melihat Rara yang hampir tiap
sabtu presentasi, saya jadi termotivasi
untuk membuat karya. Rara saja bisa, masa
saya ga bisa? Dari situ saya berinisiatif
untuk bersaing dengan Rara, ini merupakan
persaingan yang positif. Pertama saya lihat
apa yang telah dihasilkan oleh Rara,
kemudian saya tiru dan tambahkan,
sehingga lebih lengkap dari apa yang
dihasilkan oleh Rara.

sejarah piandu

Dok. JC of SMK Negeri 1 Surabaya

Suatu ketika teman saya Putri Dyah Citra
Nur Kumala Sari yang akrab dipanggil Pede
mempresentasikan sebuah karya piano
yang dibuat menggunakan greenfoot. Saya
mendapat sebuah ide dari presentasinya
saat itu. Mungkin piano tersebut akan lebih
asik kalau dibuat dengan visualisasi 3D.
Cukup dengan menggunakan game engine
milik Blender dan tinggal memanfaatkan
logic, tanpa perlu scripting.

Setelah saya bicarakan dengan Pede,
ternyata dia mendukung ide saya. Dia pun
menjelaskan sistem kerjanya, selain itu dia
juga memberikan source sound piano yang
terdiri dari 1 oktaf.



.VEDC Malang

JC of SMK Negeri 1 Surabaya diundang
pada tanggal tanggal 4 Juli 2009, untuk
andil dalam presentasi di VEDC Malang
dalam rangka seminar "Technopreneurship
di Era Open Source". Saya termasuk salah
satu dari 4 siswa yang ditunjuk untuk ikut
presentasi dalam acara tersebut. Saya
putuskan untuk presentasi Piano yang saya
buat menggunakan Blender. Saat itu saya
memiliki kendala dengan aplikasi saya
tersebut, yaitu setiap saya pindah komputer
harus setting ulang direktori file sound,
selain itu saya harus membuka Blender
terlebih dahulu sebelum memainkan.

Turut hadir dalam seminar tersebut Ir.
Gatot Hari Priowirjanto selaku direktur
SEAMOLEC, Frans Thamura selaku pendiri
JavaUserGroup Indonesia, serta Harry
Kaligis selaku Associate Director Business
Development & Community PT Sun
Microsystems Indonesia. Ini merupakan
pertama kalinya saya presentasi dihadapan
umum, biasanya hanya presentasi
dihadapan teman-teman. Karena terlalu
gugup saya sampai lupa note nada yang
sebelumnya sudah saya hafalkan untuk
dimainkan saat demo aplikasi tersebut,
hingga salah seorang pembicara bilang
'programer kok disuruh main musik'.
Perasaan tidak memakai coding deh
pianonya :p

Created by : Pandu Aji Wirawan
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http://ndundupan.blogspot.com

sejarah piandu

Setelah itu saya masih terus
mengembangkan piano. Target saya kali itu
bagaimana bisa upload piano tanpa source
codenya. Sehingga orang tidak bisa
mempelajari cara pembuatannya. Akhirnya
dua masalah yang saya hadapi bisa teratasi,
dan saya share Piano versi 1.0 untuk
pertama kalinya pada bulan september
2009 di blog saya. Setelah itu saya tidak
pernah menyentuh Blender, apalagi untuk
mengembangkan Piano.



.tutorial piano

Pertengahan September seseorang
meninggalkan link blenderindonesia.org
pada blog saya. Saya langsung bergabung
di FBI (Forum Blender Indonesia), dan
menjadi seorang pembaca pasif. Saat
[dot]Blend Magz pertama release, saya
sangat terobsesi untuk nongol disitu.
Namun saat itu saya tidak tahu harus
bagaimana agar bisa numpang di majalah
tersebut. Hingga akhirnya Mas Hiza selaku
Kaptenblender menyarankan untuk
membuat tutorial dari aplikasi piano yang
sudah saya buat. Dan akhirnya lahirlah
tutorial Piano yang dimuat pada [dot]Blend
Magz edisi 2 dan saya putuskan untuk
share file blendnya untuk dipelajari.

r2.
Level : Pemula - Menegah

sejarah piandu
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Saya teringat tutorial tersebut selesai
pada hari Jum'at pukul 2.00am dan
langsung saya kirim via email ke Mas
Hiza. Teman-teman sekelas pasti
langsung tahu apa yang ada dihari jum'at
di kelas. Ya memang salah satu pelajaran
yang malas diikuti hampir setiap anak
yang ada di kelas, yaitu PKn. Ajaibnya,
ternyata tidur jam 2 dini hari lebih dan
bangun jam 5 tidak membuat saya
merasakan kantuk. Saya malah merasa
memiliki energi sangat besar dan tidak
merasakan capek sama sekali. Saya
merasa sangat bersemangat hari itu.
Entah kenapa. Itu merupakan energi
terbesar yang pernah saya rasakan
seumur hidup saya. Setelah itu saya tidak
mengotak-atik piano.



.piandu

Setelah sekian lama tak terurus, akhirnya
dengan dorongan dari Mas Hiza saya
melanjutkan pengerjaan piano untuk

dilombakan dalam INAICTA 2010. INAICTA
yang sudah berlangsung sejak tahun 2007
ini, anehnya tidak terdengar sampai di
sekolahku yang notabene merupakan
sekolah TT yang cukup besar di Surabaya.
Guru-guru mengetahui event NASIONAL ini
dari saya dan beberapa teman saya yang
juga ingin mengikutinya.

Awalnya piano tersebut mau saya
tambahkan gamelan, namun karena terlalu
rumit(bagi saya) dan saya tidak mengetahui
susunan nada gamelan. Mas Hiza akhirnya
menyarankan untuk menambahkan seruling
dengan nada jawa, yaitu seruling pelog dan
slendro. Suara yang tadinya hanya 1 oktaf
kini menjadi 2 oktaf. Ingin rasanya
menambahkan menjadi 3 oktaf, namun
apadaya, keyboard komputer tidak mampu
menampung 3 oktaf tombol piano dalam 1
baris. Karena Pede hanya memiliki 1 oktaf
tangga nada, saya tidak tahu harus mencari
nada tangga nada kemana, hingga akhirnya
Mas Hiza memberikan tangga nada 2 oktaf
yang diambil dari LMMS dan
Freesound.org.

Nama piandu merupakan nama yang
disarankan oleh Mas Hiza, awalnya saya
ingin memberi nama ViPi (Virtual Piano).
Namun kayaknya Piandu memang lebih
menjual, selain itu juga akan mengenal
nama saya (narsis mode: on). Tim
Heroblender (Akhyar, Ajib, Lukman dan
Reda) dan Forum Blender Indonesia telah
membantu saya dalam memecahkan
beberapa masalah yang saya temui ketika
poses pembuatan Piandu.

sejarah piandu

Piandu gagal lolos dalam INAICTA. Namun
kegagalan tersebut bukanlah akhir dunia,
karena saya putuskan untuk dishare secara
gratis. Saya yakin pasti ada yang lebih baik
dari sekedar menang INAICTA. Saya rasa
itu benar. Meskipun tidak lolos INAICTA,
setidaknya Piandu telah bermanfaat bagi
orang banyak, terbukti dalam 7 bulan sejak
launchingnya Piandu sudah didownload
lebih dari 1000 kali. Melebihi target yang
saya buat.

Sampai saat ini, saya belum mendengar
nasib para Jawara INAICTA yang mendapat
dukungan dari pemerintah. Screenshot aja
belum di publish pada website resmi
INAICTA. Semoga karya mereka bisa
bermanfaat untuk orang banyak.

seruling digitdl virtudl piAno
Pelog

Teken 8 uruk ket e ey




Chapter |

splash|dot]blend

Splash screen adalah gambar
yang tampak saat sebuah game
atau programm dalam proses
loading. Pada Piandu, splash
screen bermulai dengan gambar
logo yang kemudian muncul
tulisan Piandu dan Piano Digital
Piandu dengan efek transisi.

Pada Chapter I kita akan
mempelajari cara membuat splash
screen dengan efek animasi
transisi.



Hal yang perlu kita persiapkan terlebih
dahulu adalah logo dan font tekstur. Untuk
logo saya rasa tidak masalah, karena kita
bisa ganti dengan logo atau foto sedangkan
font tekstur mungkin masih belum
memilikinya.
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Tekstur font merupakan gambar dari font.
Gambar ini memiliki format .tga. Di internet
banyak sekali tekstur teks yang tersedia
dan gratis didownload, namun terkadang
kita tidak menemukan font yang kita
inginkan. Jangan khawatir, langsung saja
download FTBlender yang bisa didownload
secara gratis di http://blendenzo.com/

FTBlender merupakan sebuah script yang
digunakan untuk mengubah / mengekspor
file font .ttf menjadi sebuah font texture
.tga. FTBlender tersedia untuk Linux dan
Windows. Untuk pengguna linux,
memerlukan wine untuk menjalankan script
tersbut. Di sini akan saya jelaskan cara
penggunaan script ini, karena saya

menggunakan linux, saya praktekkan untuk

pengguna linux saja.

Download FTBlender di situsnya :
http://blendenzo.com/

Setelah download, ekstrak
FTBlender.tar.gz

Cari font dengan format .ttf yang ingin
di eksport, dan masukkan file .ttf
tersebut kedalam folder FTBlender.

Buka terminal, dan jalankan perintah [

cd Downloads/FTBlender] (perintah ini
digunakan untuk masuk ke dalam folder
FTBlender)

= 5ORSED_ | oo GieF G-

Untuk menggunakan FTBlender kita
jalankan ftblender.exe (pilihan opsi
seperti pada gambar dibawah) ppem
namafontl.ttf].ttc]

Usage: ftblender.exe [options below] ppem fontname[.ttf|.ttc] ...

enable debugging me:

Pada contoh, saya ketikkan perintah [wine
ftblender.exe -o freesans.tga ppem
FreeSans.ttf ] > tekan Enter.



Akan muncul sebuah jendela baru yang

berisi font A - Z. Itu merupakan preview
dari texture .tga. Sebelum kita save atur
dulu hingga semua huruf nampak pada
preview. Dengan menekan panah atas untuk
memperbesar dan panah bawah untuk
memperkecil. Setelah pas, tekan F2 untuk
menyimpannya dalam bentuk
texturefont.tga.

Setelah bisa menggunakan FTBlender,
sekarang kita coba gunakan tekstur font
untuk membuat tulisan splash screen. Misal
kita akan buat tulisan Piandu (Piano Digital
Pandu).

Delete default cube > Add plane (Shift
+ A > Mesh > Plane)

Chapter | | splash.blend

masuk edit mode (TAB) > Unwrap (U >
Unwrap)

Split Window dengan cara klik kanan
pada header window > Split Area.
Setelah itu atur posisinya menjadi seperti
gambar dibawah, lalu ubah window di

kanan menjadi UV Image Editor

dengan plane masih dalam edit mode,
klik Image pada UV Image Editor >
Open > pilih font tekstur.tga
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Pilih font texture.tga »

Pada jendela UV Image editor, seleksi

semua vertex dan scale (S) dan geser
(G) face tersebut sehingga ukuran face
sama dengan satu huruf, seperti pada
gambar dibawah. Putar scroll mouse pada
UV Image editor untuk zoom in maupun
zoom out pada texture.



Ubah viewport shading menjadi textured

sehingga kita bisa melihat tampilan
texture, jika terbalik seperti pada gambar
dibawah ini, rotate (R) pada UV Image
Editor.

Masih pada edit mode, masuk ke menu

editing (F9). Buka submenu Texture
Face. Aktifkan tex (digunakan untuk
merender dengan texture), twoside
(berfungsi merender 2 sisi face), text
(berfungsi mengaktifkan gambar text
bitmap pada face) dan alpha (render
transparan tanpa background).

Fanels

Chapter | | splash.blend

Masuk menu Logic

(F4). Add property
> masukkan type data:
- String, Name: Text,
el Value: PIANDU

Kembali ke Object Mode (TAB), tekan
play game (P). Sebuah tulisan PIANDU
akan muncul di jendela 3D.

PIANDU

1 Piandu menggunakan background

warna hitam, untuk mengubah
background warna kita tekan exit game
(ESC), buka menu shading (F5) lalu pilih
tab World Button > ubah warna biru
menjadi hitam.

1 Buat tulisan PIANDU dan Piano

Digital Pandu, setelah itu posisikan
seperti pada splash screen atau sesuai
dengan keinginan.




iInput gambar

Sebelumnya, pastikan terlebih dahulu

bahwa tampilan anda merupakan top
view (Numpad 7). Add (Shift A) > Mesh >
Plane. Open > pilih gambar logo. Masih
dalam objek mode tekan U lalu pilih
Unwrap.

Jangan khawatir ketika plane menjadi

putih dan hanya nampak 1 titik hitam,
hal ini karena gambar logo berwarna putih
dan alpha untuk gambar belum kita
aktifkan. Buka Tab Texture face pada
editing (F9). Aktifkan Alpha.

atur kamera

Sebelum melangkah ke bagian animasi

splash screen, kita perlu mengatur
kamera. Ketika kita play pada Blender,
maka kita melihat game tersebut berjalan
sesuai dengan tampilan pada 3D view yang
kita atur, namun ketika kita telah
mengeksport game ke bentuk lain, maka
kita akan melihat dari sudut pandang
kamera.

Chapter | | splash.blend

Karena kita telah membuat teks dan
gambar dari tampak atas, kita juga
posisikan kamera diatas teks dan gambar.

Tekan center cursor (Shift C), sehingga
kursor berada tepat di tengah 3D view.

Ubah sudut pandang mejadi Top View

(Numpad 7) > lalu pastikan sudut
pandang orthographic (Numpad 5). Setelah
itu tekan Ctrl Alt Numpad 0 untuk
memindah Camera sesuai dengan sudut
pandang 3D View. Pada editing (F9)
aktifkan orthographic, karena splash screen
berupa bidang datar. Tekan Numpad 0
untuk melihat dari sudut pandang kamera
kemudian atur posisi tulisan dan gambar di
dalam safe title, seperti gambar di bawah
ini.

animasi splash

Animasi pada splash Piandu merupakan trik
sederhana dalam animasi tekstur



Chapter | | splash.blend

Buat sebuah plane, letakkan posisinya Seleksi semua vertex yang ada pada UV
diatas tulisan yang telah kita buat Image Editor, setelah itu scale perkecil
sebelumnya. Untuk memastikan plane di dan atur posisinya seperti pada gambar
atas tulisan, ubah sudut pandang seperti dibawah ini. Jangan lupa untuk
pada gambar dibawah ini. mengaktifkan Draw Image with Alpha dan

Alpha pada Texture Face. Beri nama
'Overlay' pada plane tersebut.

o
e
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o

Scale (S) ukuran plane sehingga
menutupi seluruh tulisan yang telah
kita buat. Scale (S) pada sumbu Y sehingga
plane memanjang dari atas kebawah seperti

pada gambar di bawah ini.

Kembali ke Object Mode (TAB) dan

tetap seleksi plane Overlay. Pada frame
1, posisikan plane tersebut seprti gambar
dibawabh ini, lalu Insert Keyframe (I) > Loc.

§ Insertkey |

Seleksi plane > Edit Mode (TAB) > UV

Calculation (U) > Unwrap. Pada UV Sgtelah itu .la.ngsung buka frame 200.
Image Editor pilih menu Image > Open > - Plndqh .posmAplane seperti gambar
pilih gambar. Pada splash screen Piandu, dibawah ini, lalu insert keyframe (I) > Loc.

saya menggunakan gambar warna hitam
yang bergradiasi transparan.

Insertkey |
R




Animasi untuk splash screen telah kita
buat, namun hal ini tidak akan berjalan
secara otomatis saat game di jalankan
dengan menekan Play Game (P). Sekarang
kita perlu mengatur logic agar animasi

tersebut berjalan ketika kita play game (P).

Buka panel Logic (F4). Add Property,
Type: Int, Name: Time. Add Always
pada Sensors. Add AND pada Controllers.
Add IPO pada Actuators, atur start 1 dan
end 200,isi FrameProp: Time. Jangan lupa
untuk menyambungkan logic seperti pada

gambar di bawah ini.

Add Property pada Sensors, atur type:

equal, Prop: Time, Value: 200. Add AND
ada Controllers. Add Game pada Actuators,

atur scene: Start New Game, isi file:
menu.blend

Chapter | | splash.blend

Add Property dengan tipe int (angka)
dengan nama Time (Variabel)

Sensors kita isi always, ini berarti setiap
kita menjalankan game, maka akan selalu
menjalankan IPO dimulai dari frame 1 dan
berakhir pada frame 200 (tergantung
pengaturan kita). FrameProp kita isi
dengan Time, berarti kita mengisi variabel
Time dengan jumlah frame yang sudah
diatur pada Logic IPO.

Property kita atur Equal dengan variabel
Time yang berjumlah 200, berarti ketika
variabel Time telah mencapai 200, maka
Property akan menjalankan Start New
Game pada file menu.blend yang sudah kita
atur pada Actuators Game. Pada Bab
selanjutnya kita akan membuat menu.blend
yang berfungsi sebagai menu Piandu.

3Jangan lupa simpan file dengan nama
splash.blend

indonesia.org
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Cara Main

menu[dot]blend [

Pada bagian ini kita akan belajar membuat
menu untuk aplikasi Piandu yang memiliki
5 buah menu. Untuk mengetahui logika
atau logic dari pembuatan menu Piandu
silakan ikuti tutorial pada chapter ini.



frame

Untuk membuat gambar tersebut kita
hanya memerlukan sebuah gambar yang
akan dijadikan frame menu. Untuk jenis
font, BEBAS! Kreasikan Piandu versimu
sendiri :D. Berikut frame gambar yang saya
gunakan untuk menu Piandu.

Frame tersebut merupakan gambar dengan
format .PNG yang transparan. Pada bagian
tengah frame tersebut saya sengaja beri
transparan untuk meletakkan nama menu
menggunakan font texture.

Saya gunakan font texture untuk membuat
nama menu agar ukuran game tidak
membengkak dan menjadi lebih ringan. Jika
masing-masing nama menu berupa gambar
tersendiri, otomatis kita akan membuat
satu gambar untuk masing-masing nama
menu. Jika satu menu mempunyai ukuran
5kb, untuk 5 buah menu berarti sudah
mencapai 25kb.

Chapter Il | menu.blend

Pindah tampilan mejadi top view

orthographic > posisikan Camera
seperti tampilan top view orthographic
(Lihat BAB I). Seleksi Camera, aktifkan
orthographic dan title safe pada panel
editing (F9). Apabila jaraknya terlalu dekat,
naikkan posisi kamera pada sumbu Z.

Add sebuah plane yang akan digunakan

sebagai frame nama menu. Atur ukuran
sesuai dengan bentuk frame dan letakkan
frame tersebut dalam area title safe.

Title safe

o
¥ View Select Object |12 ObjectMade =
v Panels [ ]

Camera F OB Camera Le

ens: Show
< Scale 7ET -

Split 3D view mejadi dua. Kiri untuk 3D
View dan kanan untuk UV Image Editor.

Seleksi plane > Masuk edit mode (TAB)

> Tekan U > Unwrap. Masukkan
gambar frame seperti yang telah kita
lakukan pada BAB I. Jangan lupa untuk
mengaktifkan Alpha pada Texture Face.
Untuk mempermudah beri nama plane
menjadi button piano. Karena menu paling
atas akan digunakan untuk nama menu
piano.



Gandakan button piano dengan

menekan tombol Shift D > geser sejajar
dengan sumbu Y. Ulangi langkah tersebut
sebanyak 3 kali, sehingga button piano
menjadi 5. Ubah nama masing-masing
button seperti gambar di bawah ini.

button_piano II

button_seruling |
button_caramain
button_credit ||
button_keluar |

nama menu

Buat sebuah plane (Shift A). Pasang

Texture font seperti yang telah kita
lakukan pada BAB II. Beri nama menu
sesuai dengan keinginan kalian dan
letakkan di tengah frame menu yang sudah
kita susun sebelumnya.

Pada Piandu saya menggunakan nama

virtual piano untuk memainkan Piano.
Seruling Digital untuk memainkan seruling.
Cara main untuk layout keyboard yang
digunakan untuk memainkan seruling dan
piano. Credits berisi kontributor Piandu.
Keluar berisi perintah untuk meuntup
aplikasi Piandu.

Chapter Il | menu.blend

Jangan lupa beri tulisan Piandu pada
atas menu :). Sehingga akan tampak
seperti gambar di bawah ini.

Sebelum melanjutkan ke tahapan

selanjutna save terlebih dahulu dengan
nama menu.blend. Karena pada splash
screen kita sudah mengatur setelah
animasinya selesai akan membuka file
menu.blend.

menu selection

Seleksi menu berfungsi sebagai penunjuk
kita menu mana yang akan kita pilih.

Buat sebuah plane dan ganti nama
plane menjadi pilih. Atur ukuran dan
posisinya agar seperti gambar di bawah ini.

Plane tersebut berada di bawah nama
menu, sehingga tidak menutupi nama
menu. Beri warna sesuai keinginan, namun
harus berbeda dengan warna background
agar kelihatan. Untuk mengganti warna
background sama dengan bab sebelumnya.




Pada frame 1, posisikan plane sebagai
background menu Virtual Piano, dan
insert keyframe dengan menekan I > Loc.

Frame 1

/

Pada frame 2, posisikan plane sebagai

background menu Seruling Digital lalu
insert keyframe lagi (I > Loc). Pada frame
3 posisikan plane sebagai background Cara
Main, frame 4 pada Credits dan frame 5
pada Keluar. Jangan lupa untuk
memasukkan keyframe pada masing-
masing frame.

| Frames

logika menu

Setelah frame 1 sampai 5 telah kita atur
posisinya, kini saatnya kita mengatur agar
seleksi menu tersebut berjalan ketika kita
tekan keyboard. Kita hanya perlu
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menggunakan logika pada Game Logic yang
disediakan Blender. Tidak perlu ribet
menggunakan scripting.

Seleksi plane pilih, Add Property beri
nama pilih dengan tipe Int, selain itu
berikan value 1.

Add Sensors Always dan aktifkan True

> Controllers AND > Actuators IPO dan
pilih typenya Property. Logika ini berarti,
jika game dijalankan, maka plane pilih akan
selalu menjalankan IPO berdasarkan value
dari property pilih, default dari property
pilih adalah 1.

Add Sensor keyboard dan masukkan key

Uparrow (klik tombol Key lalu tekan
panah atas pada keyboard) > Add
Controllers AND > Add Actuators Property
dan typenya Add, dengan Prop: pilih, Value:
-1. Logika ini berarti ketika kita tekan
panah atas pada keyboard maka property
akan berkurang, sehingga seleksi menu
dengan nama variabel pilih akan bergerak
ke frame yang lebih sedikit atau mundur

Add Sensor keyboard dan masukkan
key Downarrow (klik tombol Key lalu

tekan panah bawah pada keyboard) > Add
Controllers AND > Add Actuators Property
dan typenya Add, dengan Prop: pilih, Value
1. Logika ini berarti ketika kita tekan panah
bawah pada keyboard maka property akan
bertambah sehingga seleksi menu dengan
variabel pilih akan bergerak ke frame yg
lebih banyak atau maju..




Add Sensors Property, Type Equal dan

masukkan Prop: pilih dengan Value 6 >
Add Controllers AND > Add Actuators
Property, Type Assign dengan Value 1.
Logika ini berarti jika variabel pilih bernilai
6 maka dia akan diubah menjadi variabel
dengan value 1. Sehingga ketika seleksi
menu berada pada menu paling bawah dan
kita tambahkan value 1 (dengan menekan
tombol panah bawah sekali lagi), maka
seleksi menu akan naik ke tempat variabel
pilih yang memiliki value 1.

Add Sensors Property, Type Equal dan

masukkan Prop: pilih dengan Value 0 >
Add Controllers AND > Add Actuators
Property, Type Assign dengan Value 5.
Logika ini berarti jika variabel pilih bernilai
0 maka dia akan diubah menjadi variabel
dengan value 5. Sehingga ketika seleksi
menu berada pada menu paling atas dan
kita kurangi value 1 (dengan menekan
tombol panah atas sekali lagi), maka seleksi
menu akan turun ke tempat variabel pilih
yang memiliki value 5.

Add Sensors Keyboard dan Property.

Untuk Sensors Keyboard, masukkan key
Enter, akan muncul tulisan Ret pada
indikator Key. Sedangkan pada Property
pilih type Equal dengan Prop pilih dan
value 1 > Add Controllers AND, kemudian
kedua Sensors digabungkan pada
Controllers > Add Actuator Game, pilih
type Start new game. Pada file beri nama
piano.blend (case sensitive). Logika ini
berarti jika kita menekan tombol Enter
pada saat variabel pilih memiliki value 1
maka dia akan menjalankan file piano.blend
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Add Sensors Keyboard dan Property.

Untuk Sensors Keyboard, masukkan key
Enter, akan muncul tulisan Ret pada
indikator Key. Pada Property pilih type
Equal dengan Prop pilih dan value 2 > Add
Controllers AND, kemudian kedua Sensors
digabungkan pada Controllers > Add
Actuator Game, pilih type Start new game.
Pada file beri nama seruling.blend (case
sensitive). Logika ini berarti jika kita
menekan tombol Enter pada saat variabel
pilih memiliki value 2 maka dia akan
menjalankan file seruling.blend

Add Sensors Keyboard dan Property.

Untuk Sensors Keyboard, masukkan
key Enter, akan muncul tulisan Ret pada
indikator Key. Pada Property pilih type
Equal dengan Prop pilih dan value 3 > Add
Controllers AND, kemudian kedua Sensors
digabungkan pada Controllers > Add
Actuator Game, pilih type Start new game.
Pada file beri nama cara.blend (case
sensitive). Logika ini berarti jika kita
menekan tombol Enter pada saat variabel
pilih memiliki value 3 maka dia akan
menjalankan file cara.blend
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1 Add Sensors Keyboard dan
Property. Untuk Sensors Keyboard,
masukkan key Enter, akan muncul tulisan
Ret pada indikator Key. Pada Property pilih
type Equal dengan Prop pilih dan value 5 >
Add Controllers AND, kemudian kedua
Sensors digabungkan pada Controllers >
Add Actuator Game, pilih type Quit this
game. Logika ini berarti jika kita menekan
tombol Enter pada saat variabel pilih
memiliki value 5 maka dia keluar dari game.
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1 Dari rentengan logika diatas ada

satu yang sengaja saya lewati
terlebih dahulu, yaitu perintah ketika kita
tekan enter dengan variabel pilih memiliki
value 4. Memang sengaja saya letakkan
pada akhir karena sedikit berbeda dengan
yang sebelumnya.

1 Add Sensors Keyboard dan
Property. Untuk Sensors Keyboard,
masukkan key Enter, akan muncul tulisan
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Ret pada indikator Key. Pada Property pilih
type Equal dengan Prop pilih dan value 4 >
Add Controllers AND, kemudian kedua
Sensors digabungkan pada Controllers >
Add Actuator Scene, pilih type Set Scene,
pada SCE isikan 2.Credits (case sensitive).
Logika ini berarti jika kita menekan tombol
Enter pada saat variabel pilih memiliki
value 4 maka dia akan menampilkan scene
2.Credits

K aways  sansor
e
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Kenapa kita menggunakan scene? Menurut
saya dengan menggunakan scene kita tidak
akan membuat banyak file.blend, sehingga
akan menghemat ukuran game. Selanjutnya
kita akan membuat Scene Credits.

scene credits

Sebelum membuat scene 2.Credits, kita

ubah dulu nama Scene default yang
sudah berisi dengan menu beserta
logikanya. Beri nama 1.Menu pada scene
pertama dengan cara klik nama scene dan
ketikkan nama scene lalu tekan Enter.

~ File Add Timelne Game Render Help {¥[ =[SR.2-Model X || =[SCEA Menu




Kita perlu menggunakan angka 1 di

scene menu, karena Blender akan
secara otomatis mensortir nama scene
sesuai dengan abjad. Jika kita beri nama
scene menu, otomatis nanti scene credits
akan berada diatas scene menu. Sehingga
setelah splash screen selesai dan
memanggil file menu.blend secara otomatis
akan membuka scene credits yang letaknya
paling atas.

Add new scene > empty > beri nama

2.Credits. Kita akan mendapatkan
sebuah halaman kosong. Tambahkan
sebuah camera (Shit A > Add > Camera).
Ubah sudut pandang kamera agar
Orthographic seperti yang kita lakukan
pada Chapter I. Aktifkan title safe yang
memudahkan kita untuk mengatur posisi
objek.

$£ ¢ = wview Select Object | ¥ Object Mode

Pada dasarnya sama dengan ChapterI,

kita tambahkan tulisan seperti yang kita
lakukan untuk menambahkan tulisan pada
splash screen dan menu. Akan lebih
menarik jika ditambahkan dengan gambar
seperti yang saya buat.
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scene 2 untuk kita tambahkan sebuah
logic. Add Sensors Keyboard masukkan key
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Scene dengan type: Set Scene isikan
1.Menu. Nama scene case sensitive,
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dahulu pekerjaannya dan tekan P untuk
play game. Coba jalankan menu yang sudah
kita buat. Setelah tidak menemui masalah
langsung menuju chapter selanjutnya,
namun jika masih menemui masalah coba
otak atik lagi sesuai instruksi pada Chapter
1.

@pyleft@Pandu Ay Wirawan
ittp//panduaiinet
Aundupa
nsed under a Cre 0

Convows BT st I s | BT et ATt
(T —c)
pr e e

(o Tt e iz



Tekan B untuk kembali ke menu

piano blend

Pada chapter III kita akan mempelajari
cara membuat Virtual Piano yang ada
dalam aplikasi Piandu. Virtual piano
memiliki 2 oktaf tangga nada.

Chapter ini hanya fokus pada pembuatan
tut piano beserta logikanya, tidak
membahas modeling bentuk piano secara
keseluruhan. Sehingga untuk modeling
piano silakan berkreasi sendiri.



Ubah tampilan menjadi top view,

orthographic (Numpad 7). Ubah cube
yang sudah ada secara default Blender
menjadi bentuk pipih seperti gambar
dibawah. Caranya dengan menekan S > X >
0.3 > Enter.

Top Ortho

Scale: 0.3] along glabal X

Ubah tampilan menjadi Right view,

orthographic (Numpad 3). Perpipih
cube yang tadinya sudah kita skala di
sumbu x dengan cara menekan S > Z > 0.1
> Enter

Right Ortha

Masih dari tampak samping kanan.

Tekan Z untuk membuat tampilan
menjadi wireframe, sehingga tembus
pandang. Pindahkan 3D Cursor seperti
gambar dibawah ini (Klik kanan (untuk
yang default seleksinya menggunakan klik
kiri) dan klik kiri (untuk yang default
seleksinya menggunakan klik kanan))

Dengan posisi 3D Cursor seperti

gambar diatas, pindahkan titik tengah /
center cursor di posisi 3D cursor. Dengan
cara pilih menu Object > Transform >
Center Cursor, sehingga 3D manipultor
berada seperti gambar dibawah ini

Jangan lupa Save dengan nama
piano.blend, seperti yang telah kita atur
pada property menu.

Sebelum membuat tut piano lainnya lebih
baik kita tambahkan animasi terlebih
dahulu pada tut piano yang sudah kita buat,
dengan begitu kita tidak perlu repot-repot
memasukkan animasi satu persatu ke tut
yang lain.




Seleksi tut pertama, pada frame 1 kita

tekan I > Rot. Kita hanya perlu
memasukkan kunci rotasi, karena tut piano
hanya berubah rotasinya.

LocRot
Locseale
LocRatscale
Rotscale

Visualloc

Pindah ke frame 3 > Rotasi 5 derajat

pada sumbu X (R > X > 5 ). Setelah itu
insert keyframe rot dengan cara tekan I >
Rot.

Kita tidak perlu membuat tut piano satu
persatu. Kita cukup lakukan duplikat
dari tut piano yang sudah kita buat.

Hitung banyaknya tut yang akan kita

tambahkan. Pada Piandu yang memiliki
2 oktaf tangga nada memiliki 15 tut piano
putih.

Setelah melihat gambar diatas, lebih

efisien jika kita membuat sebuah
template baru untuk modeling piano. Ada 3
model tut yang diulang berkali-kali.

Seleksi tut dan masuk edit mode (TAB)

> Lakukan Loop Cut secara vertikal
(Ctrl + R) dua kali (putar scroll mouse
kedepan untuk memperbanyak loopcut,
lihat gambar). Enter jika sudah sesuai

Ulangi loopcut sekali lagi namun

dengan posisi horizontal, untuk yang
posisi horizontal cukup Loop Cut satu kali
pada bagian tengah

Masuk pada objek mode > Duplikat tut
1 (Shift D) > Geser sejajar sumbu X.
Beri jarak diantara kedua tut

Seleksi tut kedua > Masuk edit mode
(TAB) > Hapus 2 vertex yang berada di
ujung kanan atas.




Pindah mode seleksi menjadi edge (Ctrl

TAB) > Seleksi 2 sisi sejajar pada
bagian yang tidak memiliki face, lalu tekan
F untuk menambahkan face.

Kembali ke top view (Numpad 7) >

Masuk objek mode (TAB) > Duplikat tut
piano kedua (Shift D) > Geser pada sumbu
X. Beri jarak dengan tut piano yang kedua.

1 Masuk edit mode (TAB) > Hapus 2
vertex yang berada di ujung kiri

atas > kemudian tutup bidang yang tidak

memiliki face seperti pada tut kedua.

1 Kembali ke object mode (TAB) >
Seleksi tut pertama > Duplikat
(Shift D)> geser pada sumbu X > Letakkan
di paling kanan > Hapus 2 vertex yang

berada di ujung kiri atas.

Edges & Faces
only Faces
Edge Laop

Sebelum melanjutkan modeling tut

piano, lebih baik kita masukkan logic
terlebih dahulu kedalam 4 tut yang sudah
kita miliki. Kita cukup masukan logika
sederhana seperti berikut.

Seleksi tut pertama > Add Sensors

Keyboard > Add Controllers AND > Add
Actuators IPO, kemudian atur type IPO
menjadi Flipper, selain itu atur start pada
frame 1 dan end pada frame 3




Kita pilih type flipper agar setelah kita
tekan keyboard, secara otomatis tut
piano kembali ke frame 1.

Ulangi langkah tersebut ke semua tut
yang sudah kita buat. Pada bagian
keyboard kita atur nanti setelah semuanya

selesai.

Setelah logic kita masukkan, sekarang
kita duplikat dan tata tut piano tersebut
agar tampak seperti gambar di bawah ini

Selanjutnya kita akan memberikan

warna pada tut piano agar menjadi
putih. Buka menu shading (F5) > Material
Button > atur Color menjadi putih > Bagian
emit shader atur menjadi 0.5.

[QE - AAONE - T8

Sebelum kita lanjutkan dengan
memasukkan sound, lebih baik kita buat
tut hitam dari piano tersebut sekalian.

Caranya sama dengan cara membuat tut

piano putih, yang membedakan hanya
ukuran dan warnanya saja. Agar lebih
ringan gunakan mesh dengan 8 vertex. Kita
tidak perlu menambahkan loopcut.

5]angan lupa ubah titik tengah tut piano
hitam dan masukkan animasi pada
frame 1 dan 3 seperti yang sudah kita
lakukan pada tut piano warna putih.
Letakkan tut hitam pada tempatnya.

Sebelum memasukkan sound kedalam

masing-masing logika tut, alangkah
baiknya kita berinama masing-masing tut
piano sesuai dengan sound yang akan
dimasukkan. Saya menggunakan 1 untuk
Do rendah, sedangkan i untuk do tinggi.
Sedangkan untuk tut piano berwarna hitam
saya gunakan nama #.

Untuk mengganti nama tut, seleksi tut

yang akan diganti namanya > menu
editing (F9) > ganti pada kotak yang
ditandai.
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Setelah semua beri nama sesuai dengan

nama sound, masukkan semua file
sound bernama sounds dan letakkan folder
sound dalam satu folder dengan file blend.

Masukkan semua sound pada folder

sound kedalam library file sound kita.
Buka menu Scene (F10) > Sound Block
Buttons > Open new pada Blender sound
block

Panels ﬂmga |1—|

EBlender Sound block

Game listen

“olumne: 1.0

Game Dopr
Croppler: 1.1
Wilocity: 34

rowses existing choices or adds NEW

Setelah semua sound kita masukkan
kedalam library, kita dapat melihat
library tersebut seperti pada gambar
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Copy sound

am|:u|e Steren, 16 bif, 44100 Hz, 1

Selanjutnya masuk pada menu logic

(F4). Pada mesh dengan nama 1 saya
pilih tombol TAB pada Sensors Keyboard.
Pada actuators tambahkan Sound. Pilih
Sound dengan nama 1.wav pada library dan
pilih type play stop

_
st BT ETs
a0 et 1

REIPYE

Ulangi langkah tersebut pada semua

tut, tentunya dengan tombol keyboard
dan sound yang berbeda-beda untuk setiap
tut. Setelah itu klik File > External Data >
Make all path relative. Hal ini berguna jika
setiap kita memindahkan piano pada
komputer, kita tidak akan kehilangan suara.
Seperti yang saya alami dahulu. Setiap
pindah komputer saya harus setting ulang
letak folder.




Sebelum save, atur terlebih dahulu posisi
kamera yang diinginkan ketika memainkan
game. Untuk melihat view kamera tekan
numpad 0. Setelah itu tekan Ctrl F untuk
mengubah mode menjadi flying camera.
Dengan begitu kita dapat mengubah view
kamera dengan menggeser mouse. Untuk
menggeser kamera kita perlu tahan Shift +
Scrol Mouse lalu geser. Pilih angle kamera
yang km inginkan. Pastikan piano berada di
title safe

a4y FEF FR\RWNN G

Piano sudah bisa kita mainkan.

Selanjutnya untuk finishing kita akan
tambahkan tulisan Virtual Piano dan Tekan
B untuk kembali ke menu

Buat sebuah scene baru seperti yang

pernah kita lakukan pada bab
sebelumnya, beri nama scene tersebut
dengan nama Text.

Seperti yang sudah kita lakukan pada

BAB III tentang cara membuat menu
Credits, kita buat text seperti yang telah
kita buat pada BAB I, dengan
memanfaatkan font texture.

Tambahkan sebuah camera (Shit A >
Add > Camera). Ubah sudut pandang
kamera agar Orthographic seperti yang kita
lakukan pada BAB I. Aktifkan title safe yang
memudahkan kita untuk mengatur posisi

objek.

Atur posisi tulisan seperti gambar di
bawah ini. Atau letakkan sesuai dengan
keinginan

Save dan kembali ke Scene yang berisi
piano buatan kita.

Add Empty (Shift A > Add > Empty).

Letakkan dimana saja sesuai dengan
keinginan. Pada empty add sensors
Keyboard dengan key B > Add Controllers
AND > Add Game pilih type Start New
Game dan isikan dibawahnya menu.blend,
sehingga ketika kita tekan B saat
memainkan piano akan dikembalikan ke file




menu.blend. Selain itu add sensors always
> Add Controllers AND > Add Scene >
type Add Overlay Scene > Masukk

Scene Text (case sensitive)

Tekan save dan
kita buat.

% http://universitaskehidupan.tk




Tekan Space untuk pindah ke mode
Tekan B untuk kembali ke menu

seruling

Chapter IV ini akan menerangkan
bagaiamana cara membuat seruling digital.
Karena dalam bentuk digital, saya sempat
bingung seruling ini mau dibentuk seperti
apa? Namun akhirnya saya terinspirasi
untuk membuat piano dalam bentuk
seruling dan mengeluarkan suara seruling

juga.

Seruling digital pada Piandu dilengkapi
dengan dua tangga nada jawa, yaitu pelog
dan slendero. Untuk tangga nada pelog kita
tidak dapat memainkan suara 2 dan 5,
sedangkan untuk tangga nada slendro kita
tidak dapat memainkan suara 4 dan 7.




Chapter IV | seruling.blend

modelin g | Delete ketiga buah face yang tadi kita
extrude

Modeling seruling ini hanyalah contoh,
jika kreatif, pasti bisa membuat bentuk
seruling digital yang jauh lebih baik.

Add Circle > Masuk edit mode (TAB) >
Select all vertex (A) >Extrude (E)
>Scale (S) > 0.9.

Pindah mode seleksi menjadi edge

selection mode (Ctrl TAB)> Seleksi
edges di sekeliling face yang kita hapus
dengan cara tahan Alt dan Klik

sl L3000 v,05000 2 05000

Seleksi seluruh vertex (A) > Scale (S) >
0.5 > Enter > Extrude pada sumbu Z
sebesar 0.5 skala (E > Z > 0.5)

Extrude dan Scale dengan skala 0.9 (E
>S>0.9)

Ubah
mode
seleksi
menjadi face
selection Extrude ke dalam seperti gambar d
(Ctrl TAB) > bawah ini
Seleksi tiga
face >
Extrude >
0.09 > Enter




Tutup 3 face yang berlubang dengan
seleski kedua edge yang sejajar lalu
tekan F

] Warnai seruling sesuai dengan
selera sendiri.

~ Fanels []

[o]

1 Aktifkan set smooth pada editing

(F9). Jika modeling anda seperti
gambar sebelah kiri > masuk edit mode
(TAB) > select all (A) > Tekan Ctrl N
sehingga bisa tampak seperti gambar yang
kanan

1 Selanjutnya kita buat tut untuk
seruling digital. Caranya sama
dengan cara membuat tut pada piano. Buat
sebuah kubus dan atur ukurannya agar
sesuai dengan seruling yang sudah kita buat

Pindahkan titik tengah objek
seperti pada gambar dibawah ini.

yang kita gunakan sebagai titik pusat
rotasi. Caranya sama dengan bab
sebelumnya. Pindahkan 3D Cursor (Klik
kanan (untuk yang default seleksinya
menggunakan klik kiri) dan klik kiri (untuk
yang default seleksinya menggunakan klik
kanan)), setelah itu 3D cursor berpindah
pilih Object > Transform > Center Cursor,
sehingga 3D manipultor berada di 3D
cursor. Jangan lupa beri warna pada tut
seruling digital.

1 4 Duplikat tut seruling beserta
tempatnya sebanyak 7 kali
sehingga ada 8 tut beserta tempatnya




Saya menggunakan 8 tut karena tidak
mungkin membuat seruling dengan 15
lubang :D

1 Tambahkan sebuah circle dan

extrude untuk menjadi batang dari
seruling tersebut, lalu langsung atur posisi
seruling digital dan kamera sesuai dengan
keinginan

Sekalian beri nama pada masing-masing tut
agar lebih mudah saat input sound.

Chapter IV | seruling.blend

animasi seruling

Kali ini kita masukkan satu persatu

keyframe ke masing-masing tut. Hal ini
dikarenakan pada contoh, saya atur
posisinya dengan rotasi. Jadi apabila kita
lakukan insert keyframe rotasi pada frame
pertama dan ketiga terlebih dahulu
sebelum mengatur posisi, maka ketika
animasi berjalan dia akan tetap
menjalankan keyframe yang sudah kita
kunci, yaitu sebelum kita atur posisinya.
Jika bingung dengan tulisan ini silakan
langsung mencobanya biar lebih mengerti ;).

Ketika sudah mendapatkan posisi yang

diinginkan, seleksi satu tut pada frame
pertama lalu insert keyframe rotasi (I >
Rot). Setelah itu ubah Transform
Orientation menjadi Local.

Bla o= [tocal |

[ = View solect Object [t Obiectvode 2| [ ]
_ —

Langsung menuju frame 3, rotate

sebesar 5 derajat melalui manipulator
agar mudah. Setelah itu insert keyframe
Rot (I > Rot). Ulangi langkah tersebut
untuk semua tut seruling.




Sebelum memasukkan logic pada

seruling, terlebih dahulu kita masukkan
semua sound seruling kedalam library.
Caranya sama dengan cara memasukkan
sound pada library piano. (Pada contoh
tutorial, folder bernama seruling yang
kemudian dimasukkan kedalam folder
sound)

Buka menu scene (F10) > Sound Block
> Open New
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Buka menu Logic (F4) > Add Keyboard

pada sensors dan pilih key TAB > Add
Controllers AND > Add IPO pada Actuators
ubah typenya menjadi Flipper, Start 1 dan
End 3. Add Sound pada Actutors dan pilih
sound 1 pada library. Setelah itu Add
keyboard lagi pada sensors dengan key U >
Add Controllers AND > Add Sound pada
actuators dan pilih sound i pada Library.
Sambungkan seperti pada gambar.
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Kita buat seperti itu karena sebuah tut
dapat mewakili dua sound, dengan dua
tombol yang berbeda.

Ulangi langkah seperti itu pada tut tut

yang lain, kita bisa mengatur tombol
sesuka kita, aturlah tombol yang paling
nyaman.

Ini merupakan seruling dengan nada

pelog, jadi seruling ini tidak akan
berbunyi ketika kita tekan tombol Q, R, I, ].
Karena pada tombol yang seharusnya saya
tambahkan sound 2, 5 dengan 2 oktaf tidak
saya beri sehingga akan menjadi seruling
bisu jika ditekan.

File > External data > Make all path
relative.
= (50 Add Timeline Game Render Help | = |5R:Z-Model X =|5CI
New Ctrl %
Qpen.
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Recover Last Session
Save
Save As.
Compress File
Save Rendered Image.
Screenshot Subwindow Ctrl F3
Screenshot All il Shift F3
Save Game As Runtime.
Save Default Seflings cirly
Load Factary Settings
Append or Link Shift F1
Append or Link (image Browser) Cirl F1
Import 3
Export >

Exfernal Data Pack into _blend file
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Setelah seruling pelog selesai, kita akan

lebih mudah membuat seruling slendro.
Karena merupakan duplikat dari seruling
pelog, dan hanya kita ganti pada
pengaturan soundnya.

Ubah nama scene menjadi Pelog.

Setelah itu Add new scene > Pilih full
copy, agar sama persis. Beri nama Slendro
pada scene kedua.

X | - wwwhlenderorg 249.2

=|SR:z-Model  Add scene
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Link Objects
Link ObData

Pada seruling slendero atur agar tangga

nada 4 dan 7 tidak bisa berbunyi,
sedangkan yang pada seruling pelog tangga
nada 2 dan 5 tidak berbunyi, buat agar
berbunyi pada seruling slendro ini dengan
cara mengotak-atik logicnya

Buat sebuah scene baru seperti yang

pernah kita lakukan pada bab
sebelumnya, beri nama scene tersebut
dengan nama Text untuk tulisan seruling

Seperti yang sudah kita lakukan pada

BAB III tentang cara membuat menu
Credits, kita buat text seperti yang telah
kita buat pada BAB I, dengan
memanfaatkan font texture.

Karena dalam 1 file kita menggunakan 2

aplikasi yang terletak pada scene yang
berbeda. Kita harus memberitahu user
bahwa dia sedang memainkan mode pelog
atau slendro. Oleh karena itu kita perlu
buat sebuah logika baru untuk tulisan ini.

Pada tulisan Pelog kita tambahkan
sebuah property / variabel dengan type
integer yang bernama Pelog dengan value 1.

Add keyboard pada sensors dengan key

space / spasi > Add AND pada
controllers > Add proprerty pada actuators
dengan type Add, prop: Pelog dan dengan
value 1. Artinya ketika kita menekan spasi,
maka value pada variabel Pelog akan
bertambah 1 menjadi 2.

Add property pada sensors dengan type

equal, prop: Pelog dengan value 3 >
Add AND pada controllers > Add property
pada actuators dengan type assign, prop:
Pelog > value 1. Artinya ketika nilai pada
variabel Pelog 3 maka akan diubah menjadi
nilai 1.

Add property pada sensors dengan type

equal, prop: Pelog dengan value 1 >
Add AND pada controllers > Add visibility
pada Actuators dan aktifkan visible. Artinya
jika variabel Pelog bernilai 1 maka tulisan
Pelog akan tampak pada layar.

Add property pada sensors dengan type

equal, prop: Pelog dengan value 2 >
Add AND pada controllers > Add visibility
pada Actuators dan non aktifkan visible.
Artinya jika variabel Pelog bernilai 2 maka
tulisan Pelog tidak akan tampak pada layar.




slendro logic

Pada tulisan Slendro kita tambahkan

sebuah property / variabel dengan type
integer yang bernama Slendro dengan
value 1.

Add keyboard pada sensors dengan key

space / spasi > Add AND pada
controllers > Add proprerty pada actuators
dengan type Add, prop: Slendro dan dengan
value 1. Artinya ketika kita menekan spasi,
maka value pada variabel Slendro akan
bertambah 1 menjadi 2.

Add property pada sensors dengan type

equal, prop: Slendro dengan value 3 >
Add AND pada controllers > Add property
pada actuators dengan type assign, prop:
Slendro > value 1. Artinya ketika nilai pada
variabel Slendro 3 maka akan diubah
menjadi nilai 1.

Add property pada sensors dengan type

equal, prop: Slendro dengan value 1 >
Add AND pada controllers > Add visibility
pada Actuators dan non aktifkan visible.
Artinya jika variabel Slendro bernilai 1
maka tulisan Slendro tidak akan tampak
pada layar.

Add property pada sensors dengan type

equal, prop: Slendro dengan value 2 >
Add AND pada controllers > Add visibility
pada Actuators dan aktifkan visible. Artinya
jika variabel Slendro bernilai 2 maka tulisan
Slendro akan tampak pada layar.
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finishing

Tambahkan sebuah camera (Shit A >
Add > Camera). Ubah sudut pandang
kamera agar Orthographic seperti yang kita
lakukan pada BAB I. Aktifkan title safe yang

memudahkan kita untuk mengatur posisi
objek. Letakkan tulisan Pelog dan Slendro
pada satu tempat sehinga saling bertindihan

geruing digital
Bielogro

Buka scene slendro > Add empty. Pada

logic Add keyboard pada sensors
dengan key space / spasi > Add AND pada
controllers > Add Scene pada actuators,
pilih type set scene, dengan scene: Pelog.
Artinya jika kita berada pada scene Slendro
lalu kita tekan spasi maka kita akan
dialihkan ke scene Pelog.

Tambahkan Add keyboard dengan key B

pada sensors > Add AND pada
controllers > Add game pada actuators
dengan type start new game dan file
menu.blend. Artinya ketika kita pada scene
Slendro menekan B, maka kita akan
dialihkan ke file menu.blend (kembali ke
main menu)

4Jangan lupa tambahkan Always pada
sensors > Add AND pada controllers >
Add scene pada actuators dengan type add
overlay scene dengan scene text
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Pindah ke scene pelog > Add empty >

’ ,_.—'_'_'_'_'_'_'_._F
Atur settingan logic sama persis dengan
setingan empty pada scene Slendro. Yang
membedakan hanya pada saat kita tekan
space atur agar membuka scene Slendro.
R vt

s«aeEEEEE
x| o efe— E

(e —-
= e=—-

Save dan selesailah seruling digital yang
kita buat.
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Chapter V

lAyout Reyboard

WPiano M seruling

Tekan B untuk kembali ke menu

caraldotblenc |GG

Chapter V ini akan mengulas sedikit
tentang bagaimana membuat isi dari menu
cara main. Karena cara pembuatannya
sama persis dengan cara pembuatan isi
untuk menu credits yang sudah kita
masukkan dalam menu.blend.

Jadi pada chapter ini akan dibahas
perbedaan pembuatan credits dan cara
main.



caramain

Siapkan gambar keyboard yang bisa ada

pada zip tutorial ini. Jika perintah yang
diinputkan pada Piano dan Seruling
berbeda bisa mengedit sendiri key pada
gambar keyboard sehingga sesuai dengan
tombol yang sudah kita buat sebelumnya.

Saya tidak perlu jelaskan panjang lebar,

karena cara untuk membuat menu ini
sudah ada pada chapter membuat menu,
yang mana sama dengan membuat scene
credits. Oleh karena itu pada BAB ini saya
langsung masuk ke bagian logic. Hanya ada
sebuah logic sederhana pada menu ini.
Karena menu ini hanya menampilkan
gambar keyboard dengan layout keyboard
seperti keinginan kita.

Add Empty > Pada sensors add

keyboard dengan key B > Add AND
pada controllers > Add game pada
actuators dengan type start new game.
Inputkan menu.blend pada file. Sehingga
ketika kita tekan tombol B pada keyboard,
game akan kembali pada file menu.blend.
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Save dengan nama caramain.blend,
seperti yang telah kita inputkan pada
chapter II.

Chapter V | cara.blend

finishing

Pastikan semua file blend yang kita buat

terletak seperti gambar dibawah ini.
Jika dengan kreativitas yang dimiliki
memodifikasi, saya kurang tahu jadinya
seperti apa :D.
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Untuk menghindari hilangnya atau
berpindahnya file, kita dapat membuat
semua data yang berada di luar file
tergabung dalam sebuah file. Caranya
dengan memilih menu file > External data
> Pack into .blend file. Lakukan hal
tersebut pada tiap file.
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Save As

Compress File

Save Rendered Image
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Import 3
Export 3
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Selanjutnya kita ubah splash.blend

menjadi sebuah executable. Jangan
semua file blend diubah menjadi
executable, cukup file yang pertama kita
jalankan, yaitu splash.blend
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Gluit Blender

Untuk para pengguna linux, asal sudah

melakukan instalasi Blender dapat
menjalankan aplikasi ini, untuk pengguna
windows harus melengkapi file *.dll seperti
gambar dibawah ini.

&, avcodec-52.dll
&, avdevice-52.dIl
%, avformat-52.dil
@, avutil-50.dll
) 9nu_gettextdil
&, iconv.dil

1% libpng.dil

&, libtiff.dil

5, msvema0.dil
&, msvepa.dil
&, msversodil
- OpenAL32.dll
@, pthreadvc2.dil
&, python26.dil
- python31.dll
&, spLdll

&, swscale-0.dll
- ‘vcomp30.dil
@, wrap_oal dil
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TESTIMONI

bumbledare at Forum Blender Mohon maaf tidak semua komentar yang
Indonesia : ada di kaskus, FBI, maupun tempat lain
saya masukkan ke dalam halaman ini.
hallo bang ndudupan, gw udah liat ini Jika saya masukkan semua mungkin akan
waktu kemaren pas tahun baru.... heeee membuat halaman testimoni menjadi
alhasil gw sama temen - temen gw nyanyi bengkak, oleh karena itu saya pilih

pake aplikasi bang ndudupan ! komentar yang terbaik. hehehehe :p
hahahah....seru dah ! wkwkwk.....thanks
yah udah bikin kita bahagia, waktu itu
soalnya gw sama temen - temen ga kemana -
mana, cuma dirumah saya doang, ngumpul
ga jelas main pb, eh pas liat ni aplikasi,
akhirnya kite - kite main deh pake ni
piandu.... hahahah.... keren deh pokoke
keep improving bang ndudupan

Elfaz_Blender3d at Forum Blender
Indonesia:

Ndu sedikit kasih saran nieh,, klu bisa
Posisi Camera nya di rubah jadi seperti ini
kira2, krn tidak mungkin kan main Piano
dari samping lihat nya,,

kecuali Posisi camera nya bisa di pindah2
,,baru sesuai deh. agar terlihat seperti akan
memainkan Piano yg sebenar nya,, thx

(gambar yang dimaksud hilang :D)
lukboy at kaskus:

bagus gan software nya salut banget
gw....mw kasih saran ajah nihh.....gambar
pianonya bagusan lurus jangan
miring...sama backgroundnya bagusan
lagi...

tapi gw salut banget ma lo.......

Thread di kaskus: http://goo.gl/yEls2

Thread di blenderindonesia:
http://goo.gl/MVtAD
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Lulusan SMK Negeri 1 Surabaya tahun 2010 jurusan
Multimedia. Mulai terjun di dunia open source sejak awal
tahun 2010. Saat ini sedang berkarya bersama rekan-
rekan dibawah naungan Open Studio Society. Jejaring
studio non-profit yang berpusat di Jogja.

Kegiatan saat ini menulis tutorial tentang beberapa
software open source seperti Blender, Scribus dan juga

mengenai Sistem Operasi Ubuntu yang ditulis di blog
(http://panduaji.net).

Aktif dalam Forum Blender Indonesia (FBI), Sebuah
forum komunitas animasi open source, khususnya 3D.
sebagai admin. http://blenderindonesia.org/forum.






